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Introduction

This guide provides a base for setting up and configuring a small OmniStream™-based solution. The setup
instructions will provide information for building a system capable of sending and receiving audio and video through
OmniStream™ encoders and decoders, as well as a simple way to set up video walls and audio routing.
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Getting Started

Selecting a Network Switch

A network switch will be needed to power and pass IP traffic. A list of certified switches is provided below with
download links for prebuilt configurations. Atlona recommends using a switch from the certified list to ensure
compatibility.

Certified Switcher Download Configuration

Cisco SG300-10MPP Box Download Link | The default configuration can be found within the

OmniStream Certified Network Switches document

Cisco SG300-28MP
Cisco SG300-52MP
Cisco SG350-10MP
Cisco SG350-28MP

Cisco SG350-52MP

Box Download Link
Box Download Link
Box Download Link
Box Download Link

Box Download Link

that can be found at https://atlona.com/pdf/
OmniStream_ Certified Switches.pdf.

Cisco SG550X-24MP Box Download Link

Cisco SG550X-48MP Box Download Link

Pakedge S3L-24P Box Download Link

Luminex GigaCore 26i Box Download Link
Ruckus ICX 7150-48ZP Box Download Link

Ubiquiti ES-48-500W /ES-48-750W | Box Download Link

Velocity with Integrated AMS - Purchase or Download

For configuration of the OmniStream devices with this guide, Velocity with integrated AMS (Atlona Management
System) will be needed. AMS has two options: AT-VGW-HW-3/AT-VGW-HW-10/AT-VGW-HW-20 hardware (with
integrated AMS) or AT-AMS-SW free software. AT-VGW-HW-3/10/20 can be purchased at: https://atlona.com/
product/vgw-hw/ or AT-AMS-SW free software can be downloaded from https://atlona.com/product/at-ams-swy/.
AMS will be needed before progressing further into this setup and configuration guide.

Recommendations

e When using multiple of the same OmniStream devices, or for reference, labeling can be used. It’s best to place
the label on the front of the device for visibility. When labeling, notate the last 4 numbers of the MAC address,
found on the bottom of the unit on the label, for easier IP discovery and notation later.

e Use a component surge suppressor with line conditioning for best results.

IMPORTANT: Atlona’s warranty does not cover damage due to electrical disturbances. A component
surge suppressor with line conditioning is highly suggested, especially in areas with electrical storms.


https://atlona.com/product/vgw-hw/
https://atlona.com/product/vgw-hw/
https://atlona.com/product/at-ams-sw/
https://atlonainc.box.com/s/zxo0979vqcd2t4lelxe6ln82k7mvgizt
https://atlona.com/pdf/OmniStream_Certified_Switches.pdf
https://atlona.com/pdf/OmniStream_Certified_Switches.pdf
https://atlonainc.box.com/s/l0q7wxtnrckgr4clnl9k843ya4menolh
https://atlonainc.box.com/s/3ty9h2a2nl21csw2boa2tc0st9dxawao
https://atlonainc.app.box.com/s/rankeecnh9ey21gtrxrogkafvda2i6r8
https://atlonainc.app.box.com/s/zt893yn66iflnqctwcfsx2sc2z6rvpbh
https://atlonainc.app.box.com/s/mr18ycd1we66q5v4m2u1i4pjms1qqvzf
https://atlonainc.app.box.com/s/w2ux7ckmvd1ezsdk962nv49bxsk2sswu
https://atlonainc.app.box.com/s/o47er6etart69hxogl95c5rlzkdnp3sx
https://atlonainc.box.com/s/l8gl6566483jf5idrst9okv8qqfk16xu
https://atlonainc.box.com/s/gqdm9ulolk7mr4oxr6e28mc7xov9see4
https://atlonainc.box.com/s/cpzy20qmnfdbf8sg3gga27hgkca6ddvx
https://atlonainc.box.com/s/7mmkw4un41u77v0u7kxb6wp1ois02r5r
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Connections

Initial connections can be done without installing the devices in their final locations. Have at least one source and
display available to ensure video is passing between OmniStream devices. It is recommended these steps be
followed in the order they are written.

1. Connect all devices to the network switch using a CAT5e or higher cable. OmniStream devices will need to be
plugged into the PoE ports.

2. Have at least one source and display ready to connect to any of the OmniStream devices.
3. Once all the devices are connected to the network switch, connect the switch power supply to the power strip.

4. *Optional* If using the AT-OMNI-311, connect the USB B to USB A cable to the USB port of the PC, that will
provide the 5V power.

5. *Optional* If using the AT-OMNI-324, connect the power supply from the unit to the power strip.
6. *Optional* If using the AT-VGW-HW, connect it to the network switch.

7. *Optional* Connect the power supply to the AT-VGW-HW and power strip.
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Network Switch Configuration

Getting Started

Before working with the OmniStream devices, the network switch must be set up. This guide will provide instructions
for configuring a Cisco SG350X-24MP switch. The following steps will be the similar for most Cisco switches.
However, there may be small variations, depending on the switch model. Consult the switch User Manual for more
information.

IMPORTANT: The Network Switch Configuration chapter is divided into five sections. Each section
must be followed in the order listed below. Deviating from this order, or skipping steps within a
section, may result in unpredictable switch operation.

VLAN Setup

IPv4 Interface Setup
Setting IP Multicast
Setting up User Accounts

1. Connect a PC or laptop to the network switch. It is best to use the port that will remain on VLAN1 of the switch to
avoid the PC losing connection when settings are changed on the switch.

2. Go into the computer settings and change the IP of the PC to be on the same range as the switch.

to 192.168.1.xx, where xx represents values from 1 to 253, as long as that IP address is not already

o NOTE: If the IP address of the network switch is 192.168.1.254, then the computer should be set
assigned on that network. The default IP address for all Cisco switches is 192.168.1.254/24.

3. Launch the desired web browser and enter the IP address of the network switch into the address field, then
press [ENTER].

alaln Switch
cisco Application
Language: |ETTEDIM|

4. Enter the username and password. The default login credentials are as follows:

Username: cisco
Password: cisco

OmniStream 7
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Network Switch Configuration

5. Click the Login button.

The switch will most likely require a new password to be assigned, before going further. This step may vary
depending on the network switch. Enter the desired password, as required.

| Display Moce: R

-24MP 24-Port Gigabit PoE Stackable Managed Swit

Change Password

Flease change your passwerd from the default settings for better protection of your network

‘The minimum requirements are as follows:

« Cannot be the same as the user name.

- Cannot be the same as the current password.

«Minimum length is &

« Minimum number of character classes is 3. Cha
num

New Password Configuration
Qld Password:

New Password:

Confirm Password.

Password Strength Meter T ] s

Password Strength Enforcement Disable

ety ]

6. Click the Apply button to commit changes.

7. The Getting Started page will be displayed.

d - claco awichde6St5  Language: Disply Hode: Logout SNA  About Help
SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch I C.

Commasanes
Seing s

Configuration Wizards
This page provides easy steps to configure your device
> Stalus and Statistics
» Administration Sy Initial Setup . Quick Access

» Port Management Manage Stack Change Device Password
» Smariport

» VLAN Management
» Spanning Tree

> WAC Address Tables

Change Management Applications and Senvices Upgrade Device Software
Change Device IP Address Backup Device Configuration
Create VLAN Greats MAG-Based ACL
Configure Port Settings Create IP-Based ACL

»_IP Configuration Configure Qo8

» Security Device Status Configure SPAN

+ Access Gontrol
» Quality of Senvice

System Summary
Port Statistics
RMON Statistics
View Log

Other resources: S it| Forums

[J Do not show this page on starup

ms, Inc. All Rights Reserved

OmniStream
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Network Switch Configuration

VLAN Setup

The purpose of creating a VLAN is to separate a network into separate logical areas / broadcast domains. In this
case, the VLAN is created to isolate AV-over-IP traffic from normal network traffic.

8. Click the Display Mode drop-down list, near the upper-right hand corner of the screen, and select Advanced.

i e sichiciaeneyS ETE) [ Diplay Mode: Logout SNA About Help
cisco  SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch . Basic I C

Geiing Started

Configuration Wizards
This page provides easy steps to configure your device

» Staius ang Statistics
> Administration S+ Initial Setup . Quick Access

> Port Management Manage Stack Change Device Password
Change Management Applications and Services Upgrade Device Software
Change Device IP Address Backup Device Cenfiguration
Create VLAN Create MAC-Based ACL
Configure Port Setlings Create IP-Based ACL

Configure QoS
Device Status
» Access Control
> Quality of Service

System Summary

|| English ¥ Display Mode: EEETIES locout SNA  About Hel
oo I
Cadvanced >

©2011-2018 Cisc: ms, Inc. All Rights Reserved.

9. Select VLAN Management from the menu on the left side of the screen. The VLAN Management menu will
expand and the VLAN Settings page will be displayed. If the VLAN Setting page is not displayed, click VLAN
Management > VLAN Setting to display the page.

By Default, VLAN 1 is active. If the network is self-contained, skip to 15. Otherwise, continue with the next step.

10. Click the Add... button. The Add VLAN dialog will be displayed.

alialn ‘ o cisco  swilchde6345 Language: Dispiay Mode: Logout SMA About Help
cisco SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch I

Getting Started VLAN Settings

Dashboard

c Wizards VLAN Table

Search [0 VLANID | VLANName Originators | VLAN Interface State  Link Status
» Status and Statistics SNWP Traps
> Default Enabled Enabled
v Port Management
» Smartport

Delete

VLAN Setfings:
Interface Settings
Portto VLAN
PortVLAN Membership
» VLAN Translation
Private VLAN Settings
GVRP Setlings
» VLAN Groups
» Voice VLAN # VLAN ID: (Range: 2 - 4094)
» Access Port Mulicast TV VLAR
» Customer Port Multicast TV VLAN Name: (0/32 characters used)

[ Add VLAN - Google Chrome

@ Not secure | 192.168.0.117/csd8f3a7fd/Vmember/bridg_vlan_properties_a.htm

® VLAN

» Spanning Tree VLAN Interface State: ¥ Enable
bl Eehie gl ey Link Status SNMF Traps: & Enable

Range

» IP Configuration
» Security 3 VLAN Range: | - (Range: 2 - 4094)

» Access Control

» Qualty ot sevce —




a PaNpuIT company

Network Switch Configuration

11. Enter the numerical ID of the VLAN in the VLAN ID field. This value is required and must be within the range of 2
to 4094.

o NOTE: VLAN 1 is the Cisco default VLAN. This VLAN can be used, but it cannot be modified or
deleted.

12. OPTIONAL: Enter a name for the VLAN in the VLAN Name field. For example, the name of the VLAN could
be used to identify a department, within a company, which uses that broadcast domain. In this example,
“OmniStream” has been assigned as the name of VLAN 5.

[ Add VLAN - Geegle Chrome - O ®
A Mot secure | 192.168.0.117 /csdEf3a7fd/Vmember/bridg_vlan_properties_a.htm

= VLAM
# VLAN ID: 5 | (Range: 2 - 4094)
VLAM Mame: |C}mni5tream | (1032 characters used)

VLAM Interface State: |« Enable
Link Status SNMP Traps: |« Enable
I Range

# VLAN Range: | - (Range: 2 - 4094)

(o [ Gose |

13. Click the Apply button to commit changes. If the VLAN was successfully created, the dialog box will display a
“Success” message.

v Success. To permanently save the configuration, go to the Copy/Save Configuration page or
click the Save icon.

® VLAN
£ VLANM 1D | | (Range: 2 - 4094)
VLAN Mame: | | (0432 characters used)

VLAN Interface State: |« Enable
Link Status SNMP Traps: |« Enable
I Range

# VLAN Range: | - (Range: 2 - 4094)

(o] [ ciose |

OmniStream
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Network Switch Configuration

14. Repeat steps 11 through 13 to create as many VLANs as needed. If no additional VLANs are required, click the
Close button to dismiss the Add VLAN dialog box.

15. Click Administration, in the left-hand menu bar and select File Operations. The File Operations page will be
displayed.

16. Click the Duplicate radio button, next to Operation Type.

cisco  switchde6%45  Language: [T [ Dicplay oce: [UNIITTIRG losout SNA About Help

"eistl’ SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch

e = File Operations
Dashboard
| Configuration Wizards Operation Type: © Update File
Search () Backup File
imciakussanelyiclicliccmmmn| O Emme
Destination File Type: (@) Running Configuration
System Settings () Startup Configuration
Console Settings. Mirr guration
Stack Management Log B
User Accounts O Language File
SRRSO T Copy Method: @ HTTPHTTPS
» Time Settings O usB - . -
R - Operation Type: () Update File
~ File Management O TFTP. .
Firmware Operations © SCP (File transfer via S l:::l Backup‘ F|IE
Fie Operations| )
FEE e & ERIENE Browse... | Nofile select @ D | ‘t
DHCP Auto Confgurt uplicate
r e [+ ooty
Reboot
Harduare Resources Destination File Type: (® Running Configuration
Discovery - Bonjour
» Discovery - LLDP .
" Mg E "y Startup Configuration
Locate Device . - N B
s Mirror Configuration
Traceroute v -
Logging File

== =

4 anounan Cila

alialn — cisco  switchde6945  Language Display Mode: Logout SNA About Hepp
cisco SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch I O

Geting Started
Dashboard

Configuration Wizards &
uccess.

» Status and Statist

File Operations

Operation Type O Update File
O Backup File

System Settings
@® Duplicate

Console Setings
Stack Management Source File Name: @ Running Configuration

User Accounts
Idle Session Timeout
» Time Seftings
> System Log

O Startup Configuration
O Mirror Configuration

Destination File Name: (| Running Confiouration
@ Stariup Configuration

- Fil
Firmware Operations
File

o[ cann |

File Directory
DHCP Auto Configuratior
» PNP
Rebaot
Hardware Resources
Discovery - Bonjour
» Discovery -LLDP
» Discovery - CDP
Locate Device
Ping
Traceroute
» Port Management
» Smartport

v VLA Management

Inc. All Rights Reserved.

OmniStream 11
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Network Switch Configuration

IP Interface and DHCP Setup

The OmniStreams come with DHCP enabled. This section will configure the switch to become a DHCP server.

18. Click IP Configuration in the left-hand menu bar and select IPv4 Interface. The IPv4 Interface page will be
displayed.

cisco  switchde6s  Language: [EITRI [ Oisplay Mode: FYNNITIRA Looout SNA FndT About Hel

IPv4 Interface

Dashboard

Condousstioniiiards | 1Pv4 Routing. Enable

oo o |

1Pv4 Interface Table

[ | Interface IP Address Type IP Address Mask Status

» VLAN Management O vian1 DHCP  0.0.0.0 255255255255 Not received
> Spanning Tree [0 vian1 Default 1921681254 2552552550  Valid

» WAC Address Tables Add. Edit Delste

= IPvd Management and Interfa
IPv4 Static Routes
IPv4 Forwarding Table
» Access List
ARP
ARP Proxy
UDP RelayP Helper
» DHCP SnoopingiRelay
» DHCP Server
» IPv6 Management and Interfad
+ Policy Based Routing

cisco  switchde6945  Language: [T [ Oipiay toce: FENIERIRYG logout SNA FindT  About Hep

Getiing Started
Dashboard
Configuration Wizards

IPv4 Interface

‘ IPv4 Routing: Enable
» Status and Statistics

o[ cem |
-

» Port 1Pvd Interface Table

» Smartport [ Interface P Address Type | IP Address Mask Status
> VLAN

> Spanning Tree [ vian1 Defaull 192.168.1.254 2552552550  Valid

» MAC Address Tables Add. Edit. Delete

~ IPv4 Management and Interfa
IPv4 Interface
IPu4 Static Routes
IPv4 Forwarding Table
» Access List

e e IPv4 Interface

UDP Relay/IP Helper
» DHCP Snooping/Relay
» DHCP Server

+ IPV6 Management and Interfad

- rlcysons g IPv4 Routing: Enable

» Security
» Access Control

» Quality of Service
[—m—” Cancel ]

IPv4 Interface Table
] Interface | IP Address Type | IP Address Mask Status

] WLAMA Default 192.168.1.254 255.255.255.0 Valid

Edit. | (G Deleter])
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Network Switch Configuration

20. Check the IP settings for VLAN 1. If no changes are required, continue with Step 21. However, if a different IP
address or subnet mask need to be specified, then follow the steps below:

a. Click the check box next to VLAN 1.

b. Click the Edit button.

isco  switchde65 Language: [ENUINY [ Disploy Hode: Logout SNA FindT About Help

cisco  SG350X-24MP 24-Port Gigabit POE Stackable Managed Switch Q

IPv4 Interface

Success. To permanently save the configuration, go to the File Operations page or click the Save icon

| IPv4 Routing: Enable

f I cancel |

IPv4 Interface Table
IP Address Type | IP Address

Interface

IPv4 Forwarding Table
» Access List

ARP

ARP Proxy

UDP Relay/IP Helper .
> DHOP SnacpingRoly IPv4 Routing: Enable
» DHCP Semver

» IPvG Management and Interfad
» Policy Based Routing
» DN

— [—iﬂﬁ—] [ Cancel ]
IPvd Interface Table
Interface | IP Address Type | IP Address Mask Status

(=
m
o
—
=
o
o
[1¢]

c. The Edit IP Interface dialog will be displayed.
d. Make make the required changes, then click the Apply button to commit changes.

e. Click the Close button to dismiss the Edit IP Interface dialog box.

Y Edit IP Interface - Mogzilla Firefox

'fi,'J 192.168.1.254/cs7d5e0f3e/mis/ipaddr/system_ipcont_ipinterface_e jg.htm e V) ’if? é}

Interface: I‘u’LAN‘1 o
IP Address Type: () Dynamic IP Address
(@ StaticIP Address
IP Address: 192 168.1.254
# Mask: @ Network Mask [255.255.255.0
(7) Prefix Length | Range: 8- 30
Renew |P Address Mow: Enable
Auto Configuration via DHCP: Disabled

pply| [ Close |

OmniStream 13
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Network Switch Configuration

21. Click the Add... button. The Add IP Interface dialog box will be displayed.

22. Click the VLAN radio button, then click the drop-down list to select the VLAN that was created under VLAN
Setup (page 9).

23. Click the Static IP Address radio button.
o NOTE: It is recommended that a static IP address be assigned to a VLAN, to avoid IP changes.

24. Enter the IP address of the VLAN, in the IP Address field. In the example below, 10.1.1.254 is used. However,
any available IP address in the pool may be used.

25. Click the Network Mask radio button and enter the subnet mask. In this example, 255.255.254.0 is used.
However, depending upon the requirements, any valid network mask may be used.

alvaln, - cisco  switchde§945  Language: Display Mode: Logout SNA FindT About Hel
cisco  SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch I

Getting Started

IPv4 Interface
Dashboard
Gl guistioniizatds ‘ 1Pv4 Routing. Enable
Search
+ Status and Statistics Cancel
>
» Port IPv4 Interface Table
» Smariport [] Interface IP Address Type | IP Address Mask Status
» VLAN [] VLAN? Static  192.168.1.254 2552552550 \Valid
> Spanning Tree Add... Edit Delete
iyl dcosgiabion 3 Add IP Interface - Mozilla Firefox X
» Multicast ®
Co G 192.168.1.254 /cs7d5e0f3e/mts/ipaddr/system_ipconf ipinterface_a_jg.htm % =
v IPvd Management and Interfag
IPv4 Interface. | [ = | Bl
Interface: Unit |1 Port | GE1 LAG |1 VLAN |5 |+ Loopback
1Pv4 Static Routes © o @ o &
IPv4 Forwarding Table IP Address Type: O Dynamic P Address
» Access List @ Static IP Address
ARP
=
ARP IP Address: 10.1.1.254
UDP Relay/lP Helper  Mask ® Network Mask [255.255.254.0
» DHCP Snooping/Relay I
. g © PrefixLength Range: 8- 30

» IPVG Management and Interfad

! Foyeassanoing o s

» DNS
> Security
» Access Control

» Quality of Senvice

amhl Interface: ) Unit |1 Port IGE1 () LAG |1 ® WLAN |5 ~ | () Loog

IP Address Type: () Dynamic IP Address

S (@) Static IP Address
2 |P Address: [10.1.1.254
# Mask. @ Network Mask [255.255.254.0
i) Prefix Length | (Range: 8- 20)

26. Click the Apply button to commit changes. Repeat Steps 21 through 25 for each additional VLAN, as necessary.

27. After all VLANs have been set up, click the Close button to dismiss the Add IP Interface dialog box.

OmniStream 14
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Network Switch Configuration

28. Click DHCP Server in the left-hand menu bar under IP Configuration and select Network Pools. The Network
Pools page will be displayed.

PR — B oispiay e Logout SNA FindT About ol

[}
nfiguration Wizards Network Pools
sy Network Pool Table
—
T
—
0 results found.

» Port Management
S iport Add... Edit Delete Details
e
» Spanning Tree
» MAC Address Tables
» Multicast

~ IPv4 Management and Inte

1PV Interface
1PV Static Routes
1PV Forwarding Table

» Access List
ARP.
ARP Proxy.
UDP Relay/IP Helper

» DHCP Snooping/Relay

Address Binding

» Policy Based Routing

29. Click the Add... button. A new pop up will appear.

@ Add Network Pool - Google Chrome - 0 X

A Not secure | 10.20.40.254/cs9ed07791/mts/dncpserver/dhcp_server_network_pool_a jqhtm

= Pool Name: 7132 characters used)

=

‘Subnet 1P Address: [10.1.1252
# Mask © Network Mask [255255 2540
© PrefxLengtn |- Range 8-3

© Address Pool Start: {5707

© Address Pool End: [7570.755.

Lease Duration: ) Infinte.

® Days ] Hours Minutes (Defat

Oetat Rouer PAdess OpIN Y. @ Ao
& e
© User Defined
Domain Name Senver [P Address (Option6):  [Oher v | [£58.8
o Nae (Cpton 15 [ omcmmcenwen
NS08 WS Sener P Adkess (0o )

NetBIOS Node Type (Cpton 46) ®

SNTP Server IP Address (Option 4) [Noe v ] |

e Sener P Addess (s | —
File Senver st Name (naneiopton 66 | ] (064 cera
Conuraton e Name (ecpton 67 [ (0120

[ehopyye [ Ciose |

30. Enter the Pool Name, Subnet IP Address, and Network Mask.
31. Enter starting and ending IP addresses in to the Address Pool Start and Address Pool End fields.

32. Select the Apply button. The pop up window will close.

NOTE: Steps 33 through 36 are optional and should only be used if there is a set of IP addresses that
need to be excluded from the server. If unneeded, skip to Step 37.

33. Select Excluded Addresses from under DHCP servers in the left side menu. The new page will open.

lll |I| » _ - qaadmin  ATLabAS3 Language: [} Rd Display Mode: PRIENIINEG Logout SNA FindIT  About Help
alialn e .
cisco SG350X-48MP 48-Port Gigabit PoE Stackable Managed Switch
Getting Started “1 e
Dashboard
Configuration Wizards Excluded Addresses Table
Search Start IP Address ~ End IP Address
» Status and Statistics 0 results found.
TSSO Add... Delet

+ IPv4 Management and Inte
1PV4 Interface
1Pv4 Static Routes.
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Network Switch Configuration

34. Enter any IP address range that the DHCP server will NOT assign to devices.

35. Press the Apply button.

36. Repeat for any/all IP ranges that should be excluded.

cisco  SG350X-48MP 48-Port Gigabif BOE Stackable Managed Switch

Dashboard

* | Excluded Addresses

qaadmin  ATLabAS3 Language: [EIRIE [ Display Mode: EYIEINSRAl Logout SNA FindIT About Help

Q

Configuration Wizards

Excluded Addresses Table

Search

[ StanIPAddress End IPAddress

» Status and Statistics

[] 10110 1011254

Add. Delete

@ Add Excluded Addresses - Google Chrome — O X

A Not secure | 10.20.40.254/cs9ed07791/mts/dhcpserver/d...

+ IPv4 Management and Inte
1PV4 Interface

o S oses % Start IP Address: [10.1.1.0 |

% End IP Address: [10.1.1.254{ ]4 Empty value is invalid.

fapply| | Close |

Gaadmin  ATLabAS3 Lanuage: [EIRIE) R  Display Mode: Logout SNA FindT About Help

"thsth! SG350X-48MP 48-Port Gigabit PoE Stackable Managed Switch I C

| Properties
Dashboard

Configuration Wizards DHCP Server Status: Enable
Search

» Status and Statistics |hpply| [ cancel |

+ IPv4 Management and Inte
1PV4 Interface:
1Pv4 Static Routes
1Pv4 Forwarding Table:

» IPV6 Management and Inte
» Policy Based Routing
» DNS

- Ouality of Servica.

©2011-2019 Cisco Systems, Inc. All Rights Reserved.

38. Check the box next to Enable and press Apply to turn the unit into a DHCP server.
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Network Switch Configuration

39. Click Administration, in the left-hand menu bar and select File Operations. The File Operations page will be
displayed.

40. Click the Duplicate radio button, next to Operation Type.

cisco  switchde6945  Language: [EReIEY [ oisplay tode: Logout SNA About Help

i
€ISCOo

SG350X-24MP 24-Port Gigat;i:f PoE Stackable Managed Switch

Discovery - Bonjour “| File Operations
» Discovery - LLDP
» Discovery - CDP
) Operation Type: @® Update File
LozElED © Backup File
Fing O Duplicate
Traceroute
» Port Management Destination File Type: ® Running Cenfiguration
O startup Cenfiguration
» Smartport Mirror Configuration
» VLAN Management Logging File
» Spanning Tree. O Language File
» MAG Address Tables Copy Method: @® HTTPHTTPS i i E ra iunE
st & use ST ~—— Fil Op.e t
RS O Internal Flash
WAC Group Address @ T
IP Multicast Group Address () SCF (File ransfer via SSH)
~ IPv4 Multicast Configuratio “ File Name: Browse . Nofile selected . .
161 Snooping Operation Type: () Update File
IGMP Interface Settings
IGHP VLAN Setings |- appy || Cancer| O Backup File
IGMP Proxy
» IPv6 Multicast Configuratio . .
IGHPIULD Snaoping IP Wy (@ Du plicate
Multicast Router Port
Forward All
Unregistered Multicast H - H H
e Source File Mame: (® Running Configuration
.

() Startup Configuration
3 Mirror Configuration

ems, Inc. All Rights Reserved

Destination File Mame: Running Configuration

(® Startup Configuration

[—‘IFIIH'—H Cancel ]

41. Click the Apply button to commit changes.
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System Setiings
Console Settings
Stack Management
User Accounts

Idle Session Timeout
Time Setings
System Log

Fil

Operation Type: O Update File
O Backup File

@ Duplicate
@® Running Configuration

(O Startup Configuration
O Mirrar Configuration

Source File Name:

Destination File Name: Running Configuration

@ Stariup Configuration

Firmware Operations
File Directory
DHCP Auto Configuratior
PNP
Reboot
Hardware Resources
Discovery - Bonjour
» Discovery-LLDP
» Discovery - CDP
Locate Device.
Ping
Traceroute
» Part Management
» Smartport
+ VLA Management

=

tems, Inc. All Rights Reserved
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Port Mapping

42. Click Port to VLAN from the VLAN Management menu. By default, the Membership Type, for each physical
port (interface), is assigned as Untagged.

— cisco switchde6345 Language: Enghgh v LRI R Advanced v Logout SNA FindlT  About Help
SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch I

Getling Started
Dashooard
c Wizards VL ip Table: Showing 1-28 0f 28 | All | per page

Search
Filter VLAN D equalsto [ 1]
» Status and Statistics

N AND Interisce Type equals to | Port of Unit 1

» Port Interface Name | VLAN Mode = Membership Type = PVID

N n
cisco

*| Portto vLAN

> Smartport GE1 Access Unlagged |
GE2 Access Untagged |
VLAN Setlings GE3 Access Untagged
PR SRITCE GE4 Access Untagged
Fllli!\ll.m I ———
R D CE5 Access Untagged
e — CEB Access Untagged
Private VLAN Setings GET Aotess Untagged
GVRP Seftings GEB Access Untagged
LA EE GEY Access Untagged
> Voice VLAN o
GE10 Access Untagged

» Access Port Multicast TV VI
» Customer Port Wuflicast T\ Access Untagged
» Spanning Tree Access Untagged
» MAC Address Tables Access [Untagged  |v |
Access [Untagged ||
Access [Untagged |<

Access Untagged

43. Click VLAN ID equals to drop-down list and select the VLAN ID that was created under VLAN Setup (page
9).

44. Leave the AND Interface Type equals to drop-down list as Port of Unit 1. Click the Go button.
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c Wizards Vi ip Table Showing 1:28 0f28 (A © perpage
| Search || Firer vian D equalsto
» Status and Statistics |
R v— AND: Interface Type to [Portorunit1 D D
> Port Interface Name | VLAN L5988 e mbership Type | PVID
» Smartport GE1 Access Untagged |~

cE2 Access Untagged  |v Membe =

Bl i o VLAN rship Table

jnictaceleiins GE4 Access Untagged |~

FrimuLad QES. A Lintagned

Filter VLAM /D equals to

AND Interface Type, 1|10 |PortofUnit1 v | Go

Interface Mame = VLAMN Mcmemhershipﬁrpe PVID
GE1 ACCESS | Untagged |«
GE2 Access | Untagged |«
GE3 Arcess | Untagged |«
GE4 ACCESS | Untagged |

GFEA Arrass | Lintanned wr

45. The Membership Type, for the VLAN, will automatically be assigned as Excluded for each physical port on the
switch.
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c Wizards Vi ip Table Showing 1280728 | All - perpage

Search
Filter VLAN ID equalsto |5+
» Status and Statistics

N AND Interface Type equals to | Port of Unit 1w

» Port Interface Name | VLAN Mode = Membership Type = PVID

*| Port to vLAN

» Smarport GE1 Access Excuded
GE2 Access |Excluded ||

VLAN Settings CE3 Access [Excluded ||
iR Eiine GE4 Access [Excuded |

= ‘Membership GES. Access Excluded

+ VLAN Translation GES Access Excluded
Private VLAN Setings GET Access Excluded
GURP Seftings GE8 Access |Excluded ||
» VLAN Groups =
» Voice VLAN
» Access Port Multicast TV VI
» Customer PortMulticast ,, | | GE11 Access Excluded
[Excluded ||

Access Excluded

GE10 Access Excluded
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46. Determine which physical ports will use the selected VLAN. Click the Membership Type drop-down list for each
physical port that will use the VLAN, and set its value to Untagged. For example, if physical ports 6 and 7 will be
used for VLAN 5, then set the Membership Type for these two ports to Untagged.

Port to VLAN

VLAN Membership Table

Filter VAN 1D equals to |5 w

AMD interface Type equals to |F'UrtnfLJnit1 e Go

Interface Mame = VLAM Mode  Membership Type | PVID
GE1 Access Excluded

GEZ Access

GE3 AcCcess

GE4 Access Multicast TV VLAN
GE5S Access Excluded e

47. Scroll to the bottom of the list of ports and click the Apply button. Success messages will appear at the top and
bottom right of the screen.

NOTE: If the port the PC is connected to is moved off VLAN1 to another VLAN (say VLANS), then the PC
will need to be set to the IP settings of the new VLAN to continue.

™
Interface Settings GE1 Access Excluded
GE2 Access Excluded
Port VLAN Membership GE3 Access Excluded
LS TR E GE4 Access Untagged

Private VLAN Settings —
GVRP Setings GES Access Untagged
» VLAN Groups GES Access Untagged
» Voice VLAN GET Access Untagged

» Access Port Mufticast TV VI e Access
» Customer Port Multicast T\

Untagged

GE9 Access Untagged | w
» Spanning Tree [——
s, GET0 Access Untagged |~
» MAC Address Tables ——
GE™T Access Excluded v
GE12 Access Excluded v
= IP Configuration Rl A |
GE13 Access Excluded ~
~ IPv4 Management and Inte It 2
1Pv4 Interface GE14 Access Excluded v
|Pv4 Static Routes GE15 Access Excluded v
— otification (Notice):
1Pu4 Forwarding Table GE16 Access Excluded |- OPY-N-TRAP: The copy operation was
» Access List GET Access Excluded - pleted successfully

ARP ————
ARP Proxy GE18 Access Excluded ~
UDP RelaylP Helper GE19 Access Untagged v
» DHCP Snooping/Relay GE20 Access Excluded v
» DHCP Server GE21 Access Excuded |~
» IPvE Management and Inte GE22 e Excluded o

» PolicyBased Routing

GE23 Access Excluded
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Configuring IP Multicast

48. Click Multicast from the menu bar on the left side of the screen. The Properties window will automatically be
displayed.

cisco  switchde6945  Language: STl [ Ospiay vode: FENINEId Lodout SNA About Help
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" ~
Discovery - Bonjour Properties
+ Discovery- LLDP

» Discovery- CDP
Locate Device
Ping
Traceroute

Bridge Multicast Filtering Status: [ ] Enable

VLAN ID 1>

Forwarding Method for IPvé: (8 MAC Group Address
O IP Group Address
© Source Specific IP Group Address

» PortManagement

+ VLAN Management
» Spanning Tree
» MAC Address Tables

Forwarding Method for IPvd: (8 MAC Group Address
O IP Group Address
© Source Specific IP Group Address

Wicompraess | [tomm [ canca |
1P Multicast Group Address «
. g

©2011-201 Systems, Inc. All Rights Reserved

49. Click the Enable box, next to Bridge Multicast Filtering Status, to enable this feature.

50. Click the IP Group Address radio button, under both Forwarding Method for IPv6 and Forwarding Method for
IPv4.

Properties

Bridge Multicast Filtering Status: Enable

WLAM ID: I‘I e

Forwarding Method for IPvE: ) MA p Address
(@) |IP Group Address
() Source Specific IP Group Address

) MAC p Address
(@) |P Group Address
() Source Specific IP Group Address

Forwarding Method for 1Pv4:

[—m—] [ Cancel ]

51. Click the Apply button to commit changes.

52. Repeat steps 38 and 39 for each VLAN.

53. Click IGMP Snooping, under IPv4 Multicast Configuration, from the menu bar on the left side of the screen.

TS T -
i [ -“"ﬂ_][ Cancel ][ IGMP Snooping IP Multicast Group ]
ls
F WLAM Management
¥ 3Spanning Tree IGMP Snooping Table
» MAC Address Tables Entry Mo. | VLAMID | IGMP Snooping Status MRouter Ports | Immediate | Last Membs
| RS Administrative = Operational Auto Learn Leave Cluery Counte
Properties l 1 1 Disabled Disabled Enabled  Disabled
MAC Group Address - - -
IP Multicast Group Address R RS B
» |Pv4 Multicast Configuratio
v
< >
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54. Click the check box next to IGMP Snooping, to enable this feature.

55. Click the Apply button to commit changes.

IGMP Snooping

IGMP Snooping is only operational when Eridge Multicast Filiering is enabled. Bridge Multicast Filtering is currently enal

IGMP Snooping Status: Enable
IGMP Querier Status: Enable

Apply ][ Cancel ][IGMF’SnoopinglF’I'u'IuIticastGroup

56. Click the radio button next to VLAN 1, as shown below, in the IGMP Snooping Table.

X Save cisco  switchde6345 Language: BN [ Oispy ioce: [YNNENIRA logout SHA About Help

Q

'éllls'tl:lcl" SG350X-24MP 24-Port Gigat;it PoE Stackable Managed Switch

Discovery - Bonjour “1 icmP Snooping
+ Discovery-LLDP
» Discovery - CDP =
Locate Device Success. To permanently save the configuration, go to the File Operations page or click the Save icon.
Ping
Traceroute IGNMP Snooping is only operational when Eridge Huliicas! Fillering is enabled. Bridge Multicast Filtering is currently enabled.
» Port
» Smartport IGMP Snooping Status: [] Enable
» VLAN Management IGMP Querier Status: Enable
» Spanning Tree
» MAC Address Tables |~~pply—|| cancel || IGHP Snooping IP Multicast Group
PropT IGHP Snooping Table
MAC Group Address: EntryNo. | VLANID | IGMP Snooping Status WRouter Ports | Immediate | LastMember IGMP Querier Status IGMP Querier | IGMP Querier | Querier
IP Multicast Group Address Operational Auto Lean Leave | Query Counter Operational | Election Version 1P Address
~ IPv4 Multicast Configuratio
e
IGMP Interface Setiings v Copy Settings. Edit.
< > —

®2011-2018 Cisco Systems, Inc. All Rights Resenved

57. Click the Edit... button to display the Edit IGMP Snooping Settings dialog box.

Y Edit IGMP Snooping Settings - Mozilla Firefox

@ 192.168.1.254 /csafab2 1cd/multicast/igmp_snooping_e_jg.htm see I 1‘.'? é}
VLAM ID: I'I e
IGMP Snooping Status: [J] Enanle

MRouter Ports Auto Learn: Enable
Immediate Leave: [] Enanle

# LastMember Query Counter: (g Use Query Robustness (2)

() UserDefined | Range: 1-7
IGMP Querier Status: [] Enable
IGMP Qluerier Election: Enable
IGMP Querier Viersion: 2
Querier Source IP Address: Auto

User Defined

hpply|[ Close |




/N\T LOMN/.

a PaNpuIT company

Network Switch Configuration

58. Click the Enable checkboxes next to IGMP Snooping Status, Inmediate Leave, and IGMP Querier Status.
Make sure each of these checkboxes display a checkmark. Leave the rest of the settings as they are.

59. Click the Apply button to commit changes.

Y Edit IGMP Snooping Settings - Mozilla Firefox

(0] 192.168.1.254 /csafab2 1cd/multicast/igmp_snooping_e_jq.htm e (W) T:f
VLAM 1D: |1 v
IGMF Snooping Status: Enable

MRouter Ports Auto Learn: Enable
Immediate Leave: Enable

# LastMember Query Counter: @) Use Query Robustness (2)

() User Defined | Range: 1-7
IGMP Querier Status: Enable
IGMP Querier Election: Enable
IGMP Querier \Version: @ v2

(w3

Querier Source |P Address: @ Auto
() User Defined

192.168.1.254

tpplyf | Close |

60. Click the VLAN ID drop-down list, and select the next VLAN ID number. Repeat steps 17 and 18 for each VLAN
that was created.

61. Click the Close button to dismiss the Edit IGMP Snooping Settings dialog.

62. Click Administration > File Operations in the menu bar on the left side of the screen. The File Operations
page will be displayed.

63. Click the Duplicate radio button, next to Operation Type, then click the Apply button to commit changes.

x| Save: cisco  switchde6945  Language: [Eipeen) [ oipiay ode: FENRRIRY locout SMA  About Help

cisco SG350X-24MP 24-Port Gigabit boE Stackable Manac I <
S S| File Operations File Operations
4 E":;U:E:m?gp Operation Type: @ Update File
() Backup File
Fing O Duplicate i §
— P::::::::mem Destination File Type: (@ Running Configuration DFI'E ration T}l'p-E: l:::l Upda‘te File
T () Startup Configuration )
—] o Contourton ") Backup File
+ Spanning Tree. O Language File .
s T — (® Duplicate
v Multicast () usse _
operiis O nternsl Flas| . . . .
e S Source File Name: ® Running Configuration
IP Wulticast Group Address () SCP (File transfer via SSH) -
I e Bros... ol e () Startup Configuration
EEE%”;ET [stonte [ carcel | i) Mirror Configuration
o
" G S Destination File Mame: Running Configuration
Multicast Router Port
- (® Startup Configuration
~ IP Gonfiguration v

[—Jﬂ—] [ Zancel ]
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64. Click Unregistered Multicast from the Multicast menu on the left side of the screen. By default, all physical
ports will have port forwarding enabled, as shown below.
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cisco  switchde8945  Language: [EIT [ Display Mode: Logout SNA About Help

Getting Started . .
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Dashboard
Configurafion Wizards
Search Filter: Interface Type equalsto | Port of Unit 1w

» Status and Statistics

» Administration

» Port Management

» Smartport

» VLAN Management

» Spanning Tree

» MAC Address Tables

Froperties
MAG Group Address
1P Multicast Group Address
~ IPud Wulticast Configuration
IGMP Snooping
IGMP Interface Settings
IGMP VLAN Setiings
IGMP Proxy
» IPV6 Mutticast Configuration
IGMPIMLD Snaoping IP Multic]
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65. Click the Filtering radio button to assign port filtering to each port.

66. Click the Apply button to commit changes.

Unregistered Multicast

Port GE1
Forwarding ()

Filtering ®
Port XG1
Forwarding ()
Filtering ®

Filter. Interface Type equals to IF'ortofUniH ~

GE2 GE3 GE4 GE5 GE6

KG2 XG3 XG4

GE7 GEB GE9 GE10 GE11 GE12 GE13 GE14 GE15 GE16 GE17 GE18 GE19 GE20 GE21 GE22 GE23 GE24
O ¢ o o o o o o o oc 0o o o o o o o o o o o o o
® ©® ® ® ® ® ©@ ©® ©®@ © @ ©® ® ©® © © © @ @©® @ © © @

O O O
® ® ®

[—&pﬂy—] [ Cancel ]

67. Click Administration > File Operations in the menu bar on the left side of the screen. The File Operations
page will be displayed.

68. Click the Duplicate radio button, next to Operation Type, then click the Apply button to commit changes.
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Success.

System Settings
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Stack Management
User Accounts
Idle Session Timeout
» Time Settings
» System Log

Operation Type O Update File
O Backup File

@® Duplicate

@® Running Configuration
O Startup Configuration
O Mirror Configuration

Source File Name:

Destination File Name: =00 Confiourato
@ Startup Configuration

- Fil
Firmware Operations
File Directory
'DHCP Auto Configuratior
» PNP
Rebaot
Hardware Resources
Discovery - Bonjour
» Discovery -LLDP
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Locate Device
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v VLA Management
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Creating User Accounts

This next section is optional, and provides instructions on creating user accounts. This is only required if multiple
users will need access to the network switch.

1. Click User Accounts from the Administration menu.

cisco  switchde694!
afraafn,

cisco SG350X-24MP 24-Port Gigabit PoE Stackable Managed Switch

Getting Started

Dashboard
Configuration Wizards
Search

» Status and Statistics

User Accounts

Password Recovery Senvice: Enable

[ F— ]

i \pply 1 Cancel ]
System Settings User Account Table
Console Settings UserMame = User Level
Stack Management O cisco Read/Write Management Access (15)
User Accounts
di alata
Idle Session Timeout B REE

& Tima Qaltinne

£

@ 2011-2018 Cisco Systems, Inc. All Rights Reserved.

2. Click the Add... button to display the Add User Account dialog box.

3. Enter the desired username and password in the User Name and Password fields, respectively. Confirm the
password by re-entering it in the Confirm Password field.

4. Click the Read/Write Management Access radio button, then click the Apply button to commit changes.
5. Repeat steps 2 through 4, as required, for each user.

6. Click the Close button to dismiss the Add User Account dialog box and click Yes when prompted to save
changes.

Y Add User Account - Mozilla Firefox

GY 2 192.168.1.254/cs7Td5elf3e/mts/password/security_manage_localusers_a.htm - O

The minimum reguirements for password are as follows:

+ Cannot be the same as the user name.

= Minimum length is 8.

* Minimum number of character classes is 3. Character classes are upper case, lower case,
numeric, and special characters.

Mew User
5 User Mame: minion (6/20 characters used)
Password: (17764 characters used)

Confirm Password:

Password Strength Meter: [ T Strono
User Level: Read-Only CLI Access (1)
Re imi i I
o Read/\Write Management Access (15)

hpply|[ Ciose |
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Click Administration > File Operations in the menu bar on the left side of the screen. The File Operations
page will be displayed.

Click the Duplicate radio button, next to Operation Type.

Click the Apply button to commit changes.

. Switch configuration is complete.
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Velocity with Integrated AMS is recommended for configuration of all the OmniStream devices, but before
OmniStream is set up, Velocity must be set up and up to date. The following instructions will walk through all the
Velocity set up and OmniStream discovery steps.

Getting an IP Address

AT-VGW-HW
1. Find the IP of the VGW-HW.

a. Using the HDMI port, connect an HDMI cable from the HDMI OUT port to an HDMI IN port on the local
display. The unit IP will display at the bottom right hand corner of the display.

b. If If there is no local display, open the connected PC and do an IP scan using any IP scan program.
AT-AMS-SW

Follow the installation steps found within the AMS-SW download file. The IP address will be displayed in the Virtual
Machine window.

Login

Once the Velocity Gateway has been set up on a network, locate the IP address of the unit.

e VGW Hardware: The IP address of the server can be located by connecting to an HDMI or Mini DisplayPort
display (the IP will be located on the center of the screen) or using an IP scanner.

e VGW Software: The IP address will be located on the center of the screen after installation.

NOTE: Google Chrome is the recommended browser when using Velocity. Other browser may experience
technical difficulties and may not support full functionality.

1. Open any browser on the network and type the IP address in, as shown below.

) Products < Atlona® AVS X ¥ () Atlona Velocity | Dashbo X

& C | ® Notsecure | 192.168X XXX | 0

Velocity will automatically log in once the IP is launched and a pop up will appear.

Initial Velocity Control Gateway Setup

Basic Info Login Info Gateway Info

c * Primary admin emai *Time Zone:
A

Network 1: 192.168.41.68

Network 2: 192.168.50.240

* New ‘admin’ password Password criteria * New ‘admin’ password Password criteria * New ‘admin’ password Password criteria
""" | 8 Characters 8 Characters 8 Characters
nteger 1 Integer « Confimnation Passwond 1 Integer
* Confirmation Password 1 Lowercase * Confirmation Password T Lowercase 1 Lowercase
1 Uppercase 1 Uppercase 1 Uppercase
1 Special Character 1 Special Character 1 Special Character
swords do not match. asswords do not match Passwords Match!
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2. Fillin the initial set up information, including: Company Name, First & Last name, the email address for system
emails to be sent, time zone, and a new password.

NOTE: Passwords must be at least 8 characters and include: 1 number, 1 uppercase letter, 1 lowercase
letter, and 1 special character. The text will appear all green when the password meets all criteria.

3. Press SUBMIT once all information is filled. A new pop up will appear.

NOTE: Once the initial log in and activation is complete, the new password should be kept somewhere
easy to find. If the password is lost, please follow the directions in the Reset Password section.

Updating
Before discovery, it is best to ensure that Velocity is on the most recent firmware.

If the PC or Velocity are connected to a network with internet connectivity, Velocity will automatically check for
updates and give an update notification in the top right corner of the screen if behind. Select the icon and it will go
directly to the Firmware tab inside the System Settings. Follow step 4 of the following update instructions.

velocity .«

If the PC or Velocity do not have internet connectivity, the firmware can be checked and/or downloaded at https://
atlona.com/product/at-ams-sw/ under the Firmware tab. Velocity’s firmware version can be found at the bottom of
the main screen. If a manual update is needed, go to the firmware section within Server Settings.

1. Locate the = in the top left corner of the home page and left click to open the menu.
2. Select Settings from the menu. New options will appear.

3. Select Gateway.

= velocity

Saistey ploneon

Q  TotalRooms

% control > A Home

?
& control

& scheduling

A Management

© Hep . @ Settings
UpTime Memory Usage CPUUsage DiskUsage
f v , , = Database
(N4 61.54% 30.16% 42.93%

_ o Licenses

7w 00d ®4h ®20m X Tools

Email

@  Security

4 Network

4. Click on the field to browse the local computer for the firmware file, or drag and drop the firmware into the field.

velocity

oo o

NOTE: Velocity update files will be tar.gz file
extensions. These are compressed files and should
not be extracted before upload.

NOTE: When downloading the firmware file on a
MAC, ensure that the file is not being auto-extracted.
The option to turn off auto-extraction will be found
within the browser settings.

imm
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Firmware upgrading will start automatically.

= ] 4

EMAIL SECURITY NETWORK

LICENSES

cLoup

DATABASE

GATEWAY

Firmware Update  Current Version: 0.4.5

Drag and drop your files here or pick them from your
computer

Velocity-0.5.3.tar.gz, application/gzip 1.7e+2 Mb

T — )

When the firmware upgrade is successfully completed, a pop up window will appear. It will close a few seconds later.

OmniStream
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Discovery
Once Velocity is fully updated, all OmniStream devices can be found through the device list or rooms page. These
instructions will provide steps for device list discovery.
1. Locate the = in the top left corner of the home page and left click to open the menu.
2. Select Management from the menu. New options will appear.
3. Select AMS Device Manager.

velocity
I
Gy bR
Welcome
Q  Total Rooms [
AA
©v  Available Room Licenses 3 o o
Total Devices 0 Home
[ 3
@ Unessigned Devices 0 $ control S #  Home
@  Devices are Oniine 0 "
8  Scheduling y modified rooms 3 control >
ed 0
Atlona Customer
1 A B Scheduling >
@ Settings >
0
A Management >
& Cloud
@ AMS Device Manager
© Help >
Up Time Memory Usage CPUUsage DiskUsage B Reports
’ , , @ Settings
1 lf 61.54% 33.16% 42.33%
& Cloud
®7w @0d @4h ©20m
| o Help 2

velocity

DEVICE LIST H De

Testing v
Status - Title IP Address MAC Address Version Site - Building Room
Atlona ~
- ] ANC108D-001FEE 10.20.40.117 B398B0.001FEF 1200 Testing Atlona Room1
Building 1 ~ H
Unassigned v i 9 Sw510w-6753 10204075 00-1E06:34E7:53 2831 Unassigned Unassigned Unassigned

OmniStream devices are located through mDNS autoscan and should automatically be discovered and placed under
the unassigned list, but if a device isn’t listed (or using the AT-OMNI-311 and AT-OMNI-324), use the network scan to
find it.

1. Select the SCAN button or press the : icon next to the SCAN button. A new pop up will appear.

a. If :is selected, choose Scan from the drop down menu.

J
= Scan Network
MAG Address Device List Settings o
S ’ Avzilable Networks
Credentials Mass Update
BE9BB001:90:22 Delect Network Scan Network
Firmware %]
Scan HTTPS ports
BE98BO0TALT0
Delete All Devices [} s J
e Select Network
BEOEBO0O1:A0DE :
Expart Al hd Custom Range

eth0: 10.20.40.2/24

B 10.2040.0/24
@  10.20.40.200 - 10.20.40.255
:
@ 192.168.100.1-192.168.200.255
B 10.20.50.0/24
B 192.168.100.1-192.168.200.1

2. Select Custom Range (a new screen will take over) or the auto detected network ethO.
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OmniStream

a. If the auto detected network ethQ is selected, press Scan Network to start the scan.

b. If Custom Range is selected, select between IP Range and Subnet Scan

Scan Network

Available Networks

eth0: 192.168.11.229/24

C .

CLOSE

1. Type in the network range or subnet information.

Custom Network Scan

® 1P Range
QO subnet Scan
Start IP End IP

CANCEL

NOTE: It is recommended to keep the network range scan to under a 512 IP range. The larger the network

range, the longer the scan will take. On subnet scan, AMS will automatically limit the scan to 512 on subnet

23 or 256 on subnet 24.

Custom Network Scan

@® PRange

(O Subret Scan

Start IP End IP
192.168.11 192.168.11.254 192.168.1 92.168.11.2 %]

CANCEL SUBMIT

Custom Network Scan

QO IPRange

@® Subnet Scan

*IP Address Subnet

192.168.11.229 24

'CANCEL SUBMIT

2. Press the save icon next to IP field. A green CustomNetwork Saved Successfully message will appear at
the bottom of the page when the custom scan settings are saved.

UNDO

3. Press the Submit button to start the scan. The pop up will close when the scan is completed.

Scan Network

Availzble Networks

Custom Range

o

CLOSE
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Updating Device Firmware

Once all devices are discovered, ensure they are the correct firmware. When AMS or the PC connected to AMS is
connected to the internet, it will automatically display if an update is needed under the update list or the firmware tab
can be checked on https://atlona.com for each individual device.

1. Select the : icon within the device list (circled below) or next to the scan button and select Firmware Update from
the drop down menu. A new pop up will appear.

DEVICE LIST

Firmware Update

Device List
@ Aromn111 Sean @
Status ~ Title IP Address MAC Address Version site Building Room
@ atomni111-00355 Device List Settings el
[} at-omni-111-00355 10.20.40.55 B89BBO.01AZSD 27.DS02 Unassigned Unassigned Unassigned
@ atomni111-wp-00000 ¢
Credentials Mass Update @
¥ . WU ("] atomni-111-wp-00 10.20.40.42 B898:B0:0002:47 126 Unassigned Unassigned Unassigned
atomni-111-wp-00001 &
atomni-112-00411 : "] 20.20.40.40 889880000213 7 DS03 Unassigned Unassigned Unassigned .w
v
at-omni-112-00437 H 20 2€ =
¥ 1020.40.25 rD 204051 B89BB00TA0T0 126 Unassigned Unassigned Unassigned Delete All Devices [ ]
@ atomni112-00502
i 204046 B398B0:0T:A0D6 27 DS03 Unassigned Unassigned Unassigned Expart Al ¥
) ST Reconnect Q
L1
w . 0500 20.40.39 B8:98:B0:01:A2:84 2.7 DS03 Unassigned Unas:
at-omni-121-0050( r .
Re-sync Firmware Update
@ AToMNH221 Unassigned Uns:
View Logs 8 Device Type
- AT-OMNI-112
@ atomni-122-00446
20.40.49 B8:98:80:01:A6:03 2.7 DS03 Unassigned Unas:
@ stomni-122-00508 . Select Devices 10.20.40.25
Move Device 5
Unassigned Unasd Select All
@ atomni122-00548 H At Support Live Chat ( T-5pMpsT) B
—_ - Support Live Chat ( e at-omni-112-00502 | 10.20.40.25 | Fw. 1.2.5 Uptodate §
I " '

Select Latest Firmware

125
at-omni-1x2-upgrd-0s-1.2.4.vpup2

at-omni-dual-upgrd-os-1.2.3 .vpup2

cLose

Latest Version  ©
x

x

2. Drag and drop the firmware from the local PC or select the yellow box to browse the local computer. Once the

firmware file has been uploaded, it will appear under the Select Firmware section of the dialog box.

3. Select the firmware file name, so that it is highlighted grey.

4. Select UPDATE FIRMWARE button to begin the update process, at the bottom of the dialog box.

5. Select YES on the confirmation pop up window.

Firmware Update
ATOVNITI2

SelectDevices 10204025
Salect All

at-omni-112-00502 10.20.40.25 | Fw. 1.2.5

Select Latest Firmware

Uptodate §
Firmware Update

125

LatestVersion  ©

at-omni-1x2-upgrd-0s-1.2.4.vpup2

at-omni-dual-upgrd-0s-1.2.3 .vpup2

—
)

canceL

After the YES button is clicked, the Upgrade Firmware Started message box will be displayed at the bottom of the

page.

The progress bar for the update process will be displayed. The update process should take a few seconds. When
done, press the close button and then refresh the browser page. The update is complete.

Firmware Update

Firmware Name: “at-omni-dual-upgrd-os-1.2.1_RCO2.vpup2" X

AT-OMNI-112-192.168.11.116:80

CLOSE
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Configuring OmniStream Devices

Once all devices are up to date, they can be configured.

RICEEEE Bl Device List scan
o "
Status - Tite P Address MAC Address Version ste - Building Room
@ ator 7
'] at-omni-111-00355 10204055 BB9B800TA3S0 x Unassigned Unassigned Unassigned
L
A IR . P — —
LR ¥ aomnnwen 10204040 BB98B0000213 x Unassigned Unassigned Unassigned
L ¥ aomiizoum 10204051 889880014010 126 Unsssigned Unassigned Unassigned
§ oo
¥ comono 10204046 889680014006 y Unsssigned Unassigned Unassigned
o
@ atomn112-00502 10204039 830880014284 L1 Unassigned Unassigned Unassigned
§ oo
@ Ao "] OMNI-121 Unassigned Unassigned Unassigned
= ®  comzom  omes se98 80014613 3 s Unessiged Unesiged
@ a0
9 sonw Unsssigned Unsssigned Unessigned s
@ oo 5 B ona Ci r Sur 2 Chat (SAM PST - 5PM PS

If labeling devices, the IP address can be found on the device list, next to the MAC address. If the MAC address was
not noted, the IDENTIFY button can be used within the interface discussed in this section.

1. Select an encoder (AT-OMNI-11X), either from the Unassigned list or the name link in the device list. This will open
the encoder’s interface to the Info tab.

velocity

INPUT SERIAL SESSION ALARMS NETWORK CONFIGURATION

DEVICE INFO

DEVICE LIST

@ ArovNTI

Device Info

@ at-omni-111-0035!

@ atomnii11w Alias:
Model: AT-OMNI-112
@ atomni111w
IP Address 10.20.40 46
0 exci i) MAC Address 889880014006
@ atomni112:00437 E Firmware Version 127.0503
@ atomiz00s02 3 —
@ AroMNkI211 H
Description
@ atomni121-00501
Location:
@ ATOMNI1221 H Uptime: 17 days, 16 hours, 38 minutes
at-omni-122-00446
¢ Hostname: at-omni-112-00437
@ atomni-122-00508
O Resetusers O Resetnetwork

@ atomi

FACTORY RESET w REBOOT DEVICE
§ ATOMNI232 H
@ srovnize: . SHOW ADVANCED
@ atomni-512-00037 : m

@ atomni-512:00271 i & Atlona Customer Support Live Chat (5AM PST - 5PM PST) B

NOTE: Scroll to the bottom to find the IDENTIFY button, pressing it will blink the front LEDs of the
o currently selected OmniStream encoder.
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Configuring OmniStream Devices

2. Select the Session tab.

DEVICE INFO INPUT SERIAL SESSION ALARMS NETWORK OTHER NFIGURATION
nterface ethl nterface: eth2

SAP: [ ] sAP ®
Scrambling: . Scrambling .

Video Video

Encoder: HDMI Input 1 Encoder HOMI Input 2
Enable Video: . Enable Video: .
Destination 225.0.1.52 Destination 225.0.1.54
Multicast/Unicast Address: Multicast/Unicast Address:

Destination UDP Port 1000 Destination UDP Part 1000

TTL: 255 TTL: 255

Audio Audio

Source: HDMI1 Source: HOMI 2
Enable ACS67: . Enable AES67: .
Downmixing: Downmixing:

Enable Audio: Enable Audio:

3. For the initial configuration to make sure all things are set up to display audio and video to other devices, only the
Destination IP Address and UDP Port fields are required. Scroll down to the Video section first.

4. \Velocity will automatically assign an IP address and UDP port, notate the Video IP and Port or if preferred, type in
a new multicast IP and Port.

DEVICE INFO INPUT SERIAL SESSION ALARMS NETWORK OTHER CONFIGURATION NOTE: Start With Session
1 and repeat for all the

nterface: ethl nterface: eth2

SAP: ® SAP: ]
Serambling: [} Serambling [}

Video Video

Encoder HDMI Input 1 Encoder HDMI Input 2
Enable Video: o Enable Video: o
Destination 2250.1.52 Destination 225.0.1.54

Multicast/Unicast Address: Multicast/Unicast Address:

Destination UDP Port 1000 Destination UDP Port 1000
Lt 255 L 255
Audio Audio

Source: HDMI1 Source: HDMI 2
Enable AES67 ® Enable AESE7: ®
Downmixing Downmixing

Enable Audio: Enable Audio:

5. OPTIONAL: If the source is HDCP protected, then enable the Scrambling toggle. The toggle will turn green
when enabled. Then, specify the scrambling key in the Key field. Both the encoder and decoder must use the
same key.
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6. Scroll down to the Audio section.

7. Notate the Audio IP and Port or type in a new IP/port. The audio IP and port will differ from the video settings,
this allows audio to be routed independently from the video. It is best to have the Destination UDP Port different
than the video. So if video is 1000, use 1100 for the audio.

255 255 NOTE: Start with Session
1 and repeat for all the
Ao Ao sessions.
Source: HDMI 1 Source: HDMI 2
Enable AESE: . Enable AES67: .
I s NOTE: By default, the AT-
- OMNI-238 subscribes to
i streams in the 239.69.0.0/16
subnet.
1100
TTL 255
Control/Serial: Control/Serial:
Not Used Source: Not Used
=]

NOTE: If using AES67 audio routing, be sure to select the Enable AES67 slider so that it is green.
The AES67 audio stream will use the IP and Port from step 3.

| Enable AES67 ® |

8. Repeat this step for Session 2 if using a dual channel encoder.

NOTE: There will be extra sessions listed on the encoders, these are for redundancy. View the
OmniStream manuals to go over redundancy.

_

Name Marme
session3 session4
Interface Interface
Encoder Groups: Encoder Groups:
Group Name Group Name
session3 session4
Enable Encoder Group Enable Encoder Group
Active [ ] Active ®
Trigger Trigger
manual manual
=3 e
Members Members
SAP SAP
Serambling Scrambling
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Configuring OmniStream Devices

For Pro Series OmniStream only:

With firmware 1.2.2 or greater, Video Optimization can be used. The Video Optimization option must be the same
on both the encoder and decoder. For the Encoder this will be found in the INPUT tab.

DEVICE INFO SERIAL SESSION NETWORK CONFIGURATION
Video Optimization

HDMI Input 1 HDMI Input 2
input Input

HDMI Input 1 HOMI Input 2

Motion Video
t 900 Bit Rat 900
422 ampling 422 h ST w moments to
o ® o
off

off
= =]
NOTE: If connecting a Pro

R OmniStream series to an R-Type
=2 OmniStream, Motion Video must
be selected in Video Optimization.

HIDE ADVANCED  +
HDMI Input 1 HDMI Input 2
Cable Present ° Cable Presen °

9. Repeat steps 1 through 8 for all encoders.

10. Open a decoder (AT-OMNI-12X).

DEVICE INFO IP INPUT HDMI QUTPUT SERIAL ALARMS NETWORK OTHER CONFIGURATION
Alias:
Model: AT-OMNI-122
P Address 10.20.40.29
MAC Address B8:98:B0:01:A1:46
Firmware Version: 125
FIRMWARE UPDATE
Description:
Location:
Uptime: 14 days, 20 hours, 8 minutes
Hostname: at-omni-122-00508
O Reselusers O Resetnetwork

oo [ corr oo

11. Select the IP Input tab.

OmniStream 35
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1P Input 1 (Video 1) 1P Input 2 (Video 2)

Enabled ° Enabled °

terface: eth’ Interface: eth2

Mulicast Address: 225004 Multicast Address: 2250078
1 1000

1P Input 3 (Audio 1) 1P Input 4 (Audio 2)

Enablec ° Enabled °

terface eth Inteface eth2

Vulicast Address: 225005 Multicast Address 22500,
1" 1100

IP Input 5 (Control 1) 1P Input 6 (Control 2)

12. Set the Multicast Address to match the video Destination IP and Port from the encoder. e.g. Session 1 from the
OmniStream 112.

13. Scroll down to Input 3.

14. Enter the IP and Port from the audio source stream to be routed to HDMI OUT 1. e.g. Session 3 from the
OmniStream 112.

DEVICE INFO HOMI OUTPUT SERIAL ALARMS NETWORK o oN

1P Input 1 (Video 1) 1P Input 2 (Video 2)

Enabled ° Enabled °

stefas et eth2

Mulicast Address: 225004 2250078
1000 Por 1000

IP Input 3 (Audio 1) IP Input 4 (Audio 2)

,,,,, led ° Enabled °

rerface eth Inteface a2

Mulicast Address: 225005 Multicast Add 250077
n 1100

15. Repeat for Session 2 (Video for HDMI OUT 2) and Session 4 (HDMI OUT 2 and analog audio) on the OmniStream
dual channel decoders.

16. Repeat steps 10 through 15 for all decoders.
NOTE: If the OmniStream devices will be used in a video wall, open the HDMI OUTPUT tab and scroll to
the under the Video section and select the slider to enable Video Wall. Select Full Screen from the Stretch/
Crop Mode drop down menu under the Video section. No other settings need to be chosen at this time.
View the Video Walls (page 56) section for configuration.

HDMI Output 1 put Status cive video Video Wall
A Enable ©
Output Status No active video it s
Descrambling u Pixels
HOR °
Enabled jo}
Stretch/Crop Mode: Full Screen 1920
Key: srambling [¢]
1080
Resolution 1920x1080
HDCP
Horizontal 2
Encrypted ° Fast Switching Enable o
Vertical: 2
Supported Version 22
Rotation () %
Negotiated Version: 22 Audlo
. Edge Compensation Bezel Compensation
IP Input 2 (Backup Video)
EDID:
Top 2
Active Input Backup Video
Downmixing: Stereo Bottom: 2
Video Left 2
Status: No active audio
Video: 1P Input 1 (Video)
put (vigeo) Mute Wute ° Right 2
Volume 15 D St B
Active Input: Video SHOW ADVANCED ~
Output Status No active video
TO PRIMARY TO BACKUP
HDR: [
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Testing Connectivity

Now that all the OMNIs are set to pass and receive audio and video over IP, basic testing can start.

NOTE: Only one source and display are needed for testing, but multiple can be used, to avoid having to
disconnect and reconnect the HDMI cable from the OMNIs.

1. Connect the HDMI source to the first encoder port.
2. Connect the HDMI Display to the decoder set up to receive that stream.

If all the streams were set up correctly, audio and video will be passed.
3. Repeat steps 1 and 2 for all encoder and decoder ports.

The Audio / Video Settings section can be used to adjust video input and output resolutions and settings for each
stream. View the OmniStream manuals for more information.

4. OPTIONAL: Test routing and ensure connectivity with all the units using the Virtual Matrix.
a. Locate the = in the top left corner of the home page and left click to open the menu.
b. Select Management from the menu. New options will appear.

c. Select Virtual Matrix.

velocity
I
Gy bR
Q  Total Rooms 0 e come
AA
v Avalable Room Licenses 3 A
Total Devices 0 ® Home
[ ]
Unassigned Devi 0 & control >
@ Unassigned Devices — P
@  Devcesareonine o R .
3 $  control >
<:‘ FP— >, Atlona Customer
1 - -
& settings 5 B scheduling >
3
& cow A Management >
o >
e @ AMS Device Manager
Up Time Memory Usage CPU Usage Disk Usage
@ Reports
’ , , B Virtual Matrix
1/ 61.54% 33.16% 42.33%
@7w ©0d ®4h ©20m — & Settings ’
& Cloud
© Help >

d. To route audio and video in one press select the square that corresponds with the port and device to test.
Repeat until all units have been tested.

B OmniStream Virtual Matrix  Allsites B OmniStream Virtual Matrix Al Sites
Encoders / Decoders AT-OMNI1211 Disconnec:d AT-OMNI-5211 i = / AT-OMNI121 1 Dlscomnectd | KFOMN 821 1 Dlsconnected
@ Voo view[acwe v (@) viteo view[Fome ]
W Ao HEoAI | options | Audo HEF Al =
&y Data ) FlpMatrix HDMI T Out HDMI 1 0ut &> Dan () Flp Marx HDMI 1 Out HDMI 1 Out
AroMNHZT | ... AFOMNFI121 -
HDMI 1 In HuH HDMI 1 In i @ 0
HOMIZin i HOMI2In i @)
Disconnected ©~ [ Disconnected
ATOMNI-5121 AT-OMNI5121 o e
T i HOMIT In =i D) = D)
o i HoMI21n @0 & (@)
Disconnected ©* | w= Disconnected ©*
AT-OMNI-1111 AT-OMNIF1111
HOMI T In HuH Hu l BEYD D =] @ = D)
Disconnected ©F Disconnected
.

e. To route audio and video separately, select the audio and video icon at the top left to have the routes
display the individual streams under the devices.

f. Select each icon to switch the audio and video streams until all streams have been tested.

OmniStream 7
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Controlling the Display using the Display’s IR Remote
The same port that provides RS-232 connections also supports bidirectional IR pass-through, allowing a device to
be controlled from either the headend or the decoder endpoint. This step is optional. IR control is only supported on
RS-232 2 port (bottom set of connectors).

The following sections provide step-by-step instructions for the following topics:

e Controlling the Display using the Display’s IR Remote
e Controlling the Display using a Control System

The illustration below shows a display device being controlled from the encoder. Refer to the next page for details on
how to connect the IR emitter and IR receiver.

Blu-ray Player

P
2,
\i@//;
2

=

&

IR Remote

AT-OMNI-111

IR Signal

_—

Network Switch
Display

AT-OMNI-121

OmniStream 38
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Required Equipment

Atlona has tested and verified the following components for this application. However, other components may also
be used. Note that IR control is only supported on RS-232 2 port (bottom set of connectors) of the OmniStream
encoder and decoder.

e Xantech 789-44 4-Source Connecting Block
e Xantech 12V PSU

¢ IR Receiver (Atlona AT-IR-CS-RX)

¢ IR Emitter (Atlona AT-OMNI-IR-TX)

Connecting the IR Receiver to the Encoder

1. Unscrew the captive screw connectors on the Xantech 789-44 4-Source Connecting Block, using a regular
screwdriver, and connect the SIGNAL, GROUND, and POWER leads of the AT-IR-CS-RX to the Xantech 789-44
4-Source Connecting Block, as shown below. The presence or absence of white markings on each wire of the
AT-IR-CS-RX will denote the signal type:

IR IN = Dashed dark gray line
GND = Solid (no marking) black wire
+12VDC = solid dark gray line

Xantech 789-44PSRP
4-Source Connecting Block

AT-IR-CS-RX
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2. Connect the IR IN and GND leads, from the 789-44 4-Source Connecting Block, to the to the RX and = pins,
respectively, of the RS-232 2 port (bottom port) of the encoder, as shown.

NOTE: The IR IN, GND, and +12 VDC wires, from Step 1, have been removed from the illustration
below, for purposes of clarity.

Xantech 78944PSRP
4-Source Connecting Block

OmniStream Encoder

3. Connect the Xantech 12 V power supply (or other compatible 12 V DC power supply) to the 12VDC connector on
the Xantech 789-44 4-Source Connecting Block.

Connecting the IR Emitter to the Decoder

1. Connect the included 6-pin Phoenix connector to the RS-232 2 port on the encoder.
2. Connect the SIGNAL wire of the AT-OMNI-IR-TX, to the TX (middle) terminal on the RS-232 2 port.

3. Connect the GROUND wire of the AT-OMNI-IR-TX to the == terminal on the RS-232 2 port.

; AT-OMNI-IR-TX

OmniStream Decoder
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Identifying the Encoder using Velocity with Integrated AMS

1. Launch a web browser and enter the IP address of Velocity in the address bar.

2. Enter the required login credentials. The default login is:

Username: admin
Password: Atlona

3. Click the Login button.
4. The Velocity Dashboard will be displayed.

5. Click the = icon, in the upper-left corner of the screen.

velocity

I
Users. Product Documentation Updates
Welcome
N AA
Connecting Technology o coim
A  Home
[ A B & control ; #®  Home
View Velocity Documentation Velocity Version Notes 8 Scheduling > e moms [
e Sasatiial Jeren e y modified oo & control >
Atlona Customer
« ATANC108D A B scheduling >
©  Settings >
% Management >
& Cloud
@ AMS Device Manager
© Help >
@  Reports
@ 4 4 @
A Added A
@ Settings >
& Cloud
o 70 e

6. Select Management from the menu.

7. Select AMS Device Manager.

- r N @
DEVICE LIST H DEVICE INFO INPUT SERIAL SESSION ALARMS NETWORK OTHER CONFIGURATION
@ ATFOMNII111 H
Device Info
@ atomni-111-00355 H

@ atomni-111-wp-00000 Alias:
Model AT-OMNI-112
@ atomni-111-wp-00001
1P Address 10204046
atomni-112-00411
0) e MAC Address B8:98:80.01:A0.06
@ atomni 11200487 g Firmware Version 1.2.7.0S03

@ at-omni-112-00502 H FIRMWARE UPDATE

8. Click the desired encoder within the Device List window. The Velocity interface for the encoder will be
displayed.

9. Locate and make note of the IP address of the encoder, which can be found in the IP Address field. If using
dual-channel encoders, use the IP address in the IP Address 1 field.
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Configuring the Encoder Serial Port

The first step will be to configure the RS-232 port on the encoder to use IR. Only the RS-232 2 port supports both
RS-232 and IR. Therefore, this port must be used for IR. RS-232 port configuration is managed under the Serial
page of the encoder web interface.

1. Enter the IP address of the encoder in the address bar of the web browser.

2. Enter the required login credentials. The default login is:

Username: admin
Password: Atlona

3. Click the Login button.

4. Click Serial in the top menu bar.

AT IO

<  System information Input EDID Encoding

5. Under Serial Configuration for serial_use2, set the port to Not used.

6. Locate the Serial port configuration window group. The Name field, within this window group, should read
serial_port2. Click the Mode drop-down list and select Infrared.

7. Click the SAVE button to commit changes.

Serial port configuration

serial_port1 Name serial_port2
seria Supported modes infrared, seria
seril + Vioge
9600 infrared
serial
8 -
none
1~ Serial configuration
none = Name serial_uset
Port serial_port1 «
SAVE
Mode Cll
SAVE
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Configuring the Encoder Session

The next step is to assign the IR control for Serial Port 2 to the desired Session.

1. Click SESSION in the top menu bar.

AT LONA

System information Input EDID Encoding Serial

2. Locate the Session 1 window group.

o NOTE: Session 2 can also be used with IR. However, in this example, Session 1 will be configured.

BIE Configuration Users License Upgrade Demo
Name session? Name
Interface ethl - Interface
EncGroup  Enable O EncGroup  Enable
SAP Enable L] SAP Enable
Interval 10 Interval
Name session MName
Description Description
Criginator - Originator
Scrambling  Enable @ Scrambling  Enable
Key scrambling Key
Video Encoder vc2_encoder! - Video Encoder
Enable @ Enable
Destination IP address 225001 Destination |P address
Destination UDP port 1000 Destination UDP port
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3. Scroll down and locate the AUX section.
4. Click the Source drop-down list and select serial_port2.
AUX Source Not used « AlX Source
MNot used
SAVE Commands SAVE
serial_pori1
Comao D

5. Enable the auxiliary (AUX) channel by clicking the Enable toggle switch. When the auxiliary channel is enabled,
this toggle switch will be orange.

6. Enter the IP address of the decoder in the Destination IP Address field. This is the decoder to which the IR
emitter is connected. In this example, the decoder IP address is 10.20.200.141.

7. Enter the port number in the Destination UDP Port field.

8. Click the SAVE button to commit changes.

TTL 255 TTL

DSCP Best effort w DSCP

FEC enable O FEC enable

FEC rows 4 FEC rows

FEC columns 4 FEC columns
AUX Source serial_port2 « AUX Source

Enable @

Destination |P address 10.20.200.141 S

Destination UDP port 11200

DSCP Best effort w Name

Bidirectional O Interface

Listen port 1204 EncGroup  Enable

SAP Enable

Scrambling  Enable

OmniStream
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Configuring the Decoder Serial Port

1. Select the desired decoder within the AMS Device List window and make note of the decoder IP address.

2. Enter the required login credentials. The default login is:

Username: admin
Password: Atlona

3. Click the Login button, then click IP Input in the top menu bar.

AT O

< System information SAP Serial HDMI Output Logo Text Alarms Network

4. Scroll down to the Input 5 window group.

5. Enable Input 5 by clicking the Enable toggle switch. When enabled, this toggle switch will be orange.

6. Enter the port in the Port field. This port number must be the same port used by the encoder, and is the input of
the decoder that will receive IR data.

ﬂ IMPORTANT: Do not change the contents of the Multicast Address field. This field should be left
blank if using unicast IR.

7. Click the SAVE button to commit changes.

Name ip_inputs
Enable @
Interface eth1 «
Multicast address
Multicast Mode exclude «
filter

Addresses*

*Separate muifiple IP addresses with a comma.

Port 1200

SAVE
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IR Control

8. Click Serial in the top menu bar.

AT LOMNAA

< System information SAP

HDMI Output

Logo Text Alarmms Network

9. Locate the Serial port configuration window group. The Name field, within this group, should read serial_

port2. Click the Modes drop-down list and select Infrared.

10. Click the SAVE button to commit changes.

i Serial port configuration

serial_port1 Name
seria Supported modes
serial « Mode
9600
8 w

infrared

11. Scroll down the page and locate the Serial Configuration window group. The Name field, within this group,

should read serial_use2.
12. Click the Port drop-down list and select serial_port2.
13. Click the Mode drop-down list and select output.

14. Click the Input drop-down list and select ip_input5.

Serial configuration

Command: Display Off

Name serial_use2
Port serial_port2 -
Mode output
Input ip_input5 =
Bidirectional Interface Not used
ip_input1
Destination
IP address ip_input2
Destination ip_input3
HP por ip_input4
Enabled

Mode
ASCI

HEX

SAVE DELE

Command: Display On

Mode

ASCI

OmniStream
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IR Control

15. Click the SAVE button to commit changes.

Serial configuration Command: Display Off
Name serial_use2 Mode
Port serial_port2 - ASCI
Mode output « HEX
Input ip_inputs =
o SAVE DELE|
Bidirectional Interface — =
Destination
IP address
Destination 5004 Command: Display On
UDP port
Mode
Enabled O
ASCI
HEX
A, —
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Testing IR Functionality

1. Point IR remote to at the IR Receiver, as shown in the diagram below.

2. The IR remote will now sent IR data to the decoder where it will be relayed to the display device.

ﬂ IMPORTANT: The IR lens of the emitter must be within 1 inch (2.54 centimeters) of the IR window
on the display device. If this distance is exceeded, then IR functionality may fail.

/
Less than /9
<

or equal to 1 in. (2.54 cm)

AT-OMNI-121

OmniStream 48
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IR Control

Controlling the Display using a Control System

The following steps are similar to Controlling the Display using the Display’s IR Remote (page 38), except that the
control system wiring should be used, instead of an IR receiver, as shown below.

Blu-ray Player

Control System

%
AT-OMNI-111 \:%,

IR Signal

—_—

Network Switch
Display

AT-OMNI-121
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USB to IP Adapter

OmniStream AT-OMNI-311 and AT-OMNI-324 provide a way to connect USB devices (such as cameras, MICs, etc)
over |P.

BluRay Player

X
044/
Media Player

AT-OMNI-324

AT-HDVS-CAM

Decoder

AT-OMNI-311 !
2y
Decoder

Display

Display

1. Find the AT-OMNI-311 and AT-OMNI-324 in the left navigation, left click the :, and select reconnect from the drop
down menu.

DEVICE LIST H i i
(e gl Device List
@ ATowniann
Status - Title 1P Address MAC Address Version site - Building Room
@ atomni 11100355 -
@ comiinoms 10204055 BB9BB00TA3SD 27 DSt Unassigned Unassigned Unassigned
@ ctomni111wp00000
¢ B 9 tomni-111-wp-00. 10204042 B89BB000:02:47 126 Unassigned Unassigned Unassigned
atomn-111-wp 00001 §
@ atomni112-0041 H 1"} -omni-111-wp-00. 10.20.40.40 B898:B0:00:0213 27 DS03 Unassigned Unassigned Unassigned
@ atomni112:0043
@ aomnzoom 10204051 BB9BBO0TACT0 126 Unassigned Unassigned
§ atomni112:00502 R
"} at-omn112:00437 1020.40.46 B89BBO0TAODS 270803 Unassigned Unassigned ¥ ATOME-ST31 Reconnect
@ Arowniiz1
@ st 1710050 ("] at-omni-112-00502 10204039 B89BB00TA284 127.0s03 Unassigned Unassigned ¥ ATOME-SWa2
Re-sync
@ AToMNII221 9 ATOMNII21 Unassigned Unassigned
¥ AT-OMNI-1T
atomn-122.00446
v " ("] Jt-omn-121-00500 10204049 B89BBO0TAGO3 127 DS03 Unassigned Unassigned Eirmware U pdme
@ atomni-122:00501 ¥ AT-OMNI-121
@ srownizs Unassigned Unassigned
L E I Atlona Customer Support Live Chat (5AM PST - 5pM PST) B View Logs
¥ AT-OMNI-238
Maove Device
¥ AT-OMNI-311: 00:1B:13:02:AD:8C
RN fammaran | Delete Device
¥ AT-OMNI-324: 00:1B:13:02:AC:8B o

NOTE: Reconnecting the unit before adjusting it will ensure the units will be available in the pairing drop
down menu.
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USB to IP Adapter

2. Select either AT-OMNI-311 or AT-OMNI-324 from the device list. Pairing can be done from either unit, so the
following step will show settings updating through OmniStream 311.

velocity

DEVICE INFO

Device Info

o

ATOMNI-311: 00:18:13:02AD:8C

Mode!
ATOMNI-311

o,

1P Addess
~ 10.20.200.61

MAC Addre
00:1B:13:02:AD:8C

3. *Optional* The units will be set to DHCP by default. Select Network to adjust the network setting to static mode.

DEVICE INFO NETWORK PAIRING

DHCP Mode
DHCP

==
4. *Optional* Select Static from the DHCP Mode drop down and fill in the IP Address, Subnet, and Default Gateway.
e.g. 192.168.1.54, 255.255.255.0, and 192.168.1.1
5. Select Pairing from the top navigation. These following steps will be the same on either the AT-OMNI-311 or AT-
OMNI-324.
en OmniStream 311 [=1
51

OmniStream
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USB to IP Adapter

6. Select the unit to pair to from the drop down menu. The OmniStream 311 can pair with up to 7 USB devices, the
OmniStream 324 can pair with only 1 host. It does not matter which drop down is used on the AT-OMNI-311 as it
will assign it to any port.

7. Press the SAVE button once the device has been selected.

PAIRING

Paiing
_ ATOVNISEID20200C0 (AT OVNISEL 019 102ACES (mec U EISCRACED) pared to-hone)
Paring
None
Pai
Non
AT-OMNI-324: 10.20 200,66 (AT-OMNI-324: 00:18:13:02AC:88) (mac: 00:18:13:02:AC88) (paired to - None)
Pei
None Non
Pai
Non
Pei
Non
Pai
Non
ATOMNI-311: 10.20.200.61 (AT-OMNI-311: 00:1B:13:02AD:8C) (mac: 00:1B:13:02AD:8C)

8. The devices are now paired. Repeat steps 5 to 7 for all the OmniStream 311s and OmniStream 324s.
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IP to Analog Audio Bridge

OmniStream 238 can be set up and routed using the Dante Controller. To download the software, go to http:/www.
audinate.com. The software will be found under products > software > Dante Controller. The download button is
found on the right side of the page. Follow the instructions for downloading.

Once downloaded and installed, the AT-OMNI-238 will be automatically detected as long as the PC running Dante
Controller and OmniStream 238 are on the same network.

NOTE: By default the AT-OMNI-238 will have AES67 disabled and will need it enabled to route the AES67
audio from the OmniStream Encoders.

Media Player

Decoder

Display
AT-OMNI-238

Speakers

1. Open the Dante Controller application.

2. Double click the OMNI238 under the Dante Receivers. A new window will open.

@ Dante Controller - Network View - o x @ Dante Controller - Device View (OMNI238-121728) - [m] X
File Device View Help File Device View Help
RN E ) e & s HBEBREG for235-1217... 19 e
Routing Device Info  Clock Status _ Network Status _Events — e T
[ o
Clear Al a Danb' L Receive Channels Available Channels
Device Lock o g% Channel Signal | Connected to Status
Filter Transmitters a8 #-239.69.0.2 @ session1
tee cHoL 018239.69.0.2 (/] "
‘Sample Rate E83 -239.69.0.4 @ session2
£48 CHo2 02239.69.0.2 []
B Sync to External E
Fiter Receivers g gg o3 [N
& Latency ‘— | CHo4
@ Subscriptions = cHos 018225.0.0.2 [S)
z CHos
Tx Multicast Flows 2 e FrTY ©
AESE7 = CHO8
e
] w & = pante " CHos
+/0MNI238-121728 o HE ~ cH10 01€225.0.0.2 [S)
cHiL
cH12
CH13
CH14
CH15
cH1s
v
< >
el Unmanaged Multicast Bandwidth: 0 bps Eventlog: fil Clock Status Monitor: []
Unsubscribe Flows: 20f 32
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IP to Analog Audio Bridge

3. Select AES67 Config from the middle navigation.

@ Dante Controller - Device View (OMNI238-121728) - o X @ Dante Controller - Device View (OMNI238-121728) - o X
File Device View Help File Device View Help
[ [ad
a1 1 al OMNI238-1217... . e ol 11 o OMNI238-1217... )
Receive Status Latency Device Config Network Config AES67 Config Receive Status Latency Device Config Network Config AES67 Config
AES67 Mod AES67 Mode

Current: _Disabled Current: Disabled
Ne New: B

‘This device must be rebooted for the changes to take effect.

Tx Multicast Address Prefi ——————————————— -Tx Multicast Address Prefix
Current Prefix: Not Set Current Prefix: Not Set
New Address Prefix: set New Address Prefix: set
Reset De Reset D
[ I Reboot 1 Clear Config I [ Reboot Clear Config

4. Select the New: drop down field and select Enabled. A pop up will appear.

& Dante Controller - Device View (OMNI238-121728) - [m) X
& Dante Controller X e beree o e
& = o
Are you sure you want to enable AES67 mode for OMNI238-121728? | 1 1 1G] - «
This device must be rebooted for the changes to take effect. el iohe sty OSvbe ConND Nk Cnl| 42567 Cont

AES67 Mode

Current:  Enabled
New: |Enabled

Tx Multicast Address Prefix

Current Prefix:  239.69.XXX.XXX
New Address Prefix: Set

Reset De
[ (" Reboot 3 Clear Config

5. Select the Yes button to confirm the switch to AES67 enabled.

6. Press the Reboot button to restart the AT-OMNI-238 and finish enabling AES67. A new pop up will appear.

& Dante Controller Warning X

Are you sure you want to reboot OMNI238-121728?

=]l w

7. Select the Yes button to confirm the reboot.

The software will return to the home screen when the reboot is finished. AES67 sources will appear as source options
for the AT-OMNI-238 in the routing menu once the reboot is finished.
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IP to Analog Audio Bridge

@ Dante Controller - Network View - a X
File Device View Help
I ) Grand Master Clock: Unknown Device™ e
Routing Device Info Clock Status Network Status Events
T T
Clear Al Da 3 E-uB=
@Dante §s8 558
Device Lock g g
Filter Transmitters e 8 H
Sample Rate IR -]
Es s
Sync to Exteral E & &
Fiter Receivers - -
Latency [— i E E
=
Subscriptions 2
]
Tx Multicast Flows h g
AES67 =
H
Sample Rate Pull-up -+ [~ Dante Receivers
— OMNI238-121728 = = a
=1.16
CHoL 9 9
CHo2 /] 9
CHO3
cHo4
cHos & &
CHO6
cHo7 (SR
CHO8
CHO9
cHI0 & &
CH11
CH12
CH13
14
cHis
CH16
v
< 53
el Unmanaged Multicast Bandwidth: 0bps Eventlog: il Clock Status Monitor:

8. Open the streams with the + buttons next to the OmniStream 238 and the multicast addresses of the
OmniStream audio streams.

9. Select the cross section squares to route the streams. The streams will only appear as green checks when audio
is passing.

NOTE: Audio paths will only show green if there is an active audio signal passing. If there is no active
audio passing the connection will show a red icon.

Audio routing should be complete and audio passing.
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Video Walls

After the basic configuration of the devices is finished, the optional video wall can be set up using the room view. The
following steps will provide the simplest way to set up a video wall.

Media Player

Encoder

A, Wy

Decoder

/YO/M/

S

Video Wall
1. Select the = button from the top left corner and select Control.
2. More options will appear. Select All Rooms. A new screen will open.

3. Select the Edit Room Technology button on the room tile. The Modify Technology screen will open.

velocity

# Home

$ * Technology

2 AllRooms

Lo Device Drivers

Device Groups

B Scheduling >
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Video Walls

4. Press the small + in the top right corner of the Technology header. A new menu will slide open on the left side of
the screen.

5. Type Video Wall into the search bar and press enter.

6. Select the Add button next to the Velocity-Video-Wall when it appears.

Technology (All FOom B wE 0 %9

X Technology (All) B @ A
@  StARCH  CLEAR  REQUESTORVER
& Video Wal| Search ) SEARCH CLEAR
i Equipment
% ] rn Atlona: Miscellaneous: Velocity Video Wall: VELOCITY-
& @ VIDEO-WALL o
B o A Internal
o
‘I
v
11. Press the Clear button located next to the search.
12. Select the Networked (Unassigned) label, this will expand the field.
13. Add all the OmniStream devices associated with the Video Wall.
14. Click outside of the menu, or select the X at the top to return to the room.
15. Select the Edit button (circled below) on the Video Wall. The Video Wall configurator screen will open.
X Technology (All) B @ A i4: Modify Room  AllSites» A» Buiding 1> Large Conference Room
Search (M) SEARCH CLEAR
€ Networked (Room Assigned) o [ e | o = . o | o =
Rooms: ATOMNI-1121 AT-OMNI1221 AT-OMNI-521 1
OmniStream Single-Channel Networked AV Decoder 1020200139 pinging B T - s o 8 @ ; o 8 @ § v e
Rooms: 4 8 8 ! > 8 Qo o s
AT-OMNI-521 s
OmniStream R-Type Single-Channel Networked AV Decoder 102020093 pingng B
Rooms:

16. Select the Edit button. A new pop up window will appear.
e Alias - Provide an Alias for the Video Wall.

¢ Lock Pixel Space - This locks and unlocks the resolution of the video wall. By default this is enabled. Dis-
able to select a custom size and resolution in the Pixel Space Dimensions area.

e Allow custom drop zones slider - Select this to allow the creation of custom drop zones.
¢ Pixel Space Dimensions - When unlocked, the resolution of the video wall can be selected here.

x Video Wall Configuration ID- 5¢6{69a0604d940ca87c2649
VideoWall
oo A Pheispce D B om = as(s)a [o- B~ ~

Alow drop zone
Pixel Space Dimensions

AODREMANING IOENTIEY
SIZETO DEVICES.

cLose

OmniStream 7
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Video Walls

17. Double click or drag and drop the wanted decoders from the Displays area. Only drag and drop the decoders
that will be used for the video wall.

18. Auto arrange the displays by dragging a mouse over the grid to the correct display layout and left clicking.

Video Wall Configuration ID- 5c6f69a0e04d940ca87c2649 x Video Wall Configuration ID- 5¢6f69a0e04d940ca87c2649

Displays ~ PixelSpace [ 3 m m A ® /s & O- B e ~ Dieplays ® PixelSpace [ & = ®é\l/¢\o—a--~
7 X Auto Amange (2x1) 7 x
Qsromn Kroun221:2 ArouN1z21 1
e Toz0zmo 13 mEO ey
I 7% [nmm sl
o sz - f252
ooood
Qo (=]
‘‘‘‘‘ -
L o O O et T =
o (=}

19. Select the Preset button (circled below) to have sources and presets become available for selection and adding.

20. The sources will not be selectable until a preset has been added, press the ADD button (circled below) in the
Presets field. A pop up will appear.

21. Name the preset and press the enter key to close or select the close button.

22. Add as many presets as needed.

Video Wall Configuration ID- 5c6f69a0e04d940ca87c2649
Preset Edit
Sowens A PixelSpace c@- o€ |88 /s & O- B =~
m AT-OMNI-521:1 AT-OMNI-122 1:1
= otz Tozm a0 :
new
-
= CLOSE
-
- X Video Wall Configuration ID- 5¢702dfee04d940ca87cf70c
oz 12 =
e N oz sz sowces N PxelSpace ) i m O B E /@ O0- B e ~
m AFOMNI-521:1 AT-OMNI-121:1
Tos020013
rowzz12 oz
proses A oz 200101 Toznzongan

23. Select the source and drag and drop it into the decoders. The source will appear over one of the displays as a
different colored square.

Video Wall Configuration ID- 5¢702dfee04d940ca87cf70c x Video Wall Configuration ID- 5¢702dfee04d940ca87cf70c

Sources ~ PixelSpace D 2 m D E B8 § /s a &- B e~

“AToMNSZIY “ATOMNLTZI 7 AToMNLZIY
102020095, To20200 130 1020200139
ATOMNI-1121:0
(225003:1000)
-
ATOWNTZ2 12 ArouNIZ2 11 ATOMN1Z212 ArouNi2211
020200131 presets ~ 1020200131 1020200131

A0 DEETE COPY e a0 omeTe copy
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Video Walls

24. Select the source square and arrange it over the decoders it should display on. Placing it centered over
intersecting lines will have it fill up all the connected decoders.

Video Wall Configuration ID- 5¢702dfee04d940ca87cf70c x Video Wall Configuration ID- 5¢702dfee04d940ca87cf70c

Sowrces - Pielspace O 5 1= 2 E BN /s & |6 B w ~ Sources ~ PielSpace ) 3t ® P E &8/ & & B =~
V e = —
i n
25. Repeat for each configuration needed.
Video Wall Configuration ID- 5¢702dfee04d940ca87cf70c NOTE: The preset being Curr’ently set iS
oo o flosem B0 o@ o aje-(@®~ -~ highlighted in blue on the left.
ATOMNI-52 7 x 7%
i e e NOTE: Multiple sources can be used in a

preset, each will show up in different colors.

oz
T
- .
n "
T 0]

DT ADD DELETE COPY

If the video wall picture is satisfactory, continue with step 26. If picture adjustment is needed to compensate for the
display’s bezel, continue to step 27.
26. Select the save button (circled above) and exit out of the configuration screen once complete.

27. Select the edit button (circled below) on the top right of the display field. A pop up will appear.

28. Select the Bezel Compensation tab.

Pixel Space [ 2 ) = A § /7 a4 O- B = ~
= AT-OMNI-521 AT-OMNI-521
<

ATOMNI121:1
1020200139 LocATION N BEZEL COMPENSATION

ATOMNISZ1:1
102020093

ATOMNI1221:2 ATOMNHIZ21:1
1020200131 1020200131

Rotation

Rotate 180 degrees

cLose cLose
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Video Walls

29. Select the Enable slider to allow for bezel compensation. The bezel fields will unlock.

30. Type or use the arrows to adjust the bezel pixel size in each area that requires compensation. e.g. If the display is
in the top left of the video wall, the right and bottom bezel should be compensated for.

AT-OMNI-521 AT-OMNI-521
Enabl o Enable ®
] :
CLOSE CLOSE

NOTE: If the bezel needs to be adjusted for in a format other than pixel, return to the device view within the
device list from configuration and open the HDMI OUTPUT tab. Scroll to the under the Video Wall slider
and select the unit type for adjustment (Pixels, Millimeters, or Inches). Select the SHOW ADVANCED button,
then select Bezel Compensation from the Edge Compensation drop down and then enter the correct
amount, before pressing the save button.

Video deo Wall
Video Wall
,,,,, 3 1P Input 1 (Video 1) Enable: ®
Enable:
Unit: Pixels
D 1921
oR ° Display Width 1920 Display Height: 100
o Keep Aspect Ratio
0
Display Height: 1080
uto 0
0
oSG Eebie Ps Horizontal 0 . 0
- 0
Vertical 9 \satior Som a
N oot o 1) Edge Compensation. Bezel Compensation
Audio 1 Rotation (): 90 = 0
9 Ner Bot 0
Edge Compensation None
Left 0
Mute Mute [
Volume “ 15 @ Fasl Switching Enable [ ] Right 0
SHOW ADVANCED + TO PRIMARY T0 BACKUP Fast Swilching Enable [ ]
m TopriARY il TO BACKUP
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